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Notice

All information included in this document is current as of the date this document isissued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful atention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

Y ou should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. Y ou are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any lossesincurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. Y ou should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the devel opment of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errorsin or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’ s quality grade, as
indicated below. Y ou must check the quality grade of each Renesas Electronics product before using it in aparticular
application. You may not use any Renesas Electronics product for any application categorized as “ Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not bein any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “ Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “ Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances, machine tools; personal electronic equipment; and industrial robots.
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.
“Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or heathcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose adirect threat to human life.
Y ou should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especialy with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physica injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as aresult of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sdes office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics’ as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.




To all our customers

Regarding the change of names mentioned in the document, such as Hitachi
Electric and Hitachi XX, to Renesas Technology Corp.

The semiconductor operations of Mitsubishi Electric and Hitachi were transferred to Renesas
Technology Corporation on April 1st 2003. These operations include microcomputer, logic, analog
and discrete devices, and memory chips other than DRAMs (flash memory, SRAMSs etc.)
Accordingly, although Hitachi, Hitachi, Ltd., Hitachi Semiconductors, and other Hitachi brand

names are mentioned in the document, these names have in fact all been changed to Renesas
Technology Corp. Thank you for your understanding. Except for our corporate trademark, logo and
corporate statement, no changes whatsoever have been made to the contents of the document, anc
these changes do not constitute any alteration to the contents of the document itself.

Renesas Technology Home Page: http://www.renesas.com

Renesas Technology Corp.
Customer Support Dept.
April 1, 2003
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Cautions

1. Hitachi neither warrants nor grants licenses of any rights of Hitachi’s or any third party’s patent, copyright, trademark,
or other intellectual property rights for information contained in this document. Hitachi bears no responsibility for
problems that may arise with third party’s rights, including intellectual property rights, in connection with use of the
information contained in this document.

2. Products and product specifications may be subject to change without notice. Confirm that you have received the late
product standards or specifications before final design, purchase or use.

3. Hitachi makes every attempt to ensure that its products are of high quality and reliability. However, contact Hitachi’'s
sales office before using the product in an application that demands especially high quality and reliability or where its
failure or malfunction may directly threaten human life or cause risk of bodily injury, such as aerospace, aeronautics,
nuclear power, combustion control, transportation, traffic, safety equipment or medical equipment for life support.

4. Design your application so that the product is used within the ranges guaranteed by Hitachi particularly for maximum
rating, operating supply voltage range, heat radiation characteristics, installation conditions and other characteristics.
Hitachi bears no responsibility for failure or damage when used beyond the guaranteed ranges. Even within the
guaranteed ranges, consider normally foreseeable failure rates or failure modes in semiconductor devices and employ
systemic measures such as fail-safes, so that the equipment incorporating Hitachi product does not cause bodily injur
fire or other consequential damage due to operation of the Hitachi product.

5. This product is not designed to be radiation resistant.

6. No one is permitted to reproduce or duplicate, in any form, the whole or part of this document without written approval
from Hitachi.

7. Contact Hitachi's sales office for any questions regarding this document or Hitachi semiconductor products.
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Preface

About this guide

This guide explains the use of the Hitachi FLASH Development Toolkit (hereafter referred to as FDT).
Chapter 1, Introduction, provides a brief explanation to the tool and lists its key features.

Chapter 2, System Overview, describes how the different facilities make up the FDT Graphical User Interface.
Chapter 3, Basic Operation, describes how the FDT is activated and the FLASH ROM is written.

Chapter 4, Configuring the User Interface, provides a way to configure the FDT Graphical User Interface.

Chapter 5, Menus, and chapter 6, Windows, give reference information about the operations and facilities
available through these respective areas.

Assumptions

It is assumed that the reader is experienced in using Mictoatifidows’ applications on PC-compatible
computers.



Document Conventions

This manual uses the following typographic conventions:

Table 1: Typographic Conventions

CONVENTION

MEANING

[Menu->Menu Option]

Bold text with -> is used to indicate menu options (for example,
[File->Save As...]).

‘dialog name’

The “ is used to indicate the name of a dialog box or menu.

FILENAME.C

Uppercase names are used to indicate filenames.

“enter this string”

Used to indicate text that must be entered (excluding the
quotes).

Key+Key Used to indicate required key presses. For example. Ctrl+N
means press the Ctrl key and then, whilst holding the Ctrl key
down, press the N key.

= When this symbol is used, it is always located in the left-hand

(The “how to” symbol)

margin. It indicates that the text to its immediate right is describing
“how to” do something.

IBM is a registered trademark of International Business Machines Corporation.

Windows’ is a registered trademark of Microsoft Corporation.

F-ZTAT is a trademark of Hitachi, Ltd.



Chapter 1 Introduction

The Hitachi FLASH Development Toolkit (FDT) is an on-board FLASH programming tool for Hitachi F-ZTAT
microcomputers that provides a high-performance and user-friendly Graphical User Interface (GUI).

FDT is intended to be used with the Hitachi Embedded Workshop (HEW), to provide a complete solution for
the embedded software developer using Hitachi F-ZTAT microcomputers.

FDT may also be used as a general purpose S-Record or Binary editor.

1.1 Key Features

« Standard window operation based on the 32-bit WintiaBsI.
¢ Various online help functions.

¢ Selectable messaging levels.

¢ Simple programming environment using an adapter board.
¢ Serial communication: maximum 115,200 bits/s.






Chapter 2 System Overview

FDT is a modular software system, utilising self-contained modules for specific tasks. These modules are linked
to a general purpose Graphical User Interface, which providesmon look & fedhdependent of the
particular modules with which the system is configured.

FDT employs a hierarchical structure so that work can be organised in a logical manner. The top level of the
structure is the workspace.

To be useful, the workspace must contain at least one project. In order to create a project, a workspace must be
created first.

Each project specifies its own target device configuration (specified when creating the project) and set of target
files (S-Record / Binary) that can be used to program the device.

The project settings for the target device connection need only be set once, as they are stored between sessions.

A single project within the workspace is active at any point in time. The Active project is the context to which
all Device Menu, Project Menu and Project Toolbar commands will be directed.

When a project has been created, target files can be added to it. These files may be:

¢ Used to program the device.
¢ Used to build a Device Image.
¢ Opened in the binary editor.

The files added to a project are automatically copied from their original source location. In copying a file, a
dependency link is created such that if the original source file is modified then the copied version in the project
may be updated upon request.

When using a project it is possible to take advantage of the following FDT features:

¢ Target file dependency checking.

¢ Advanced messaging levels.

« Device Image builder.

* Uploading data from the target device.

2.1 User Interface

The FDT Graphical User Interface is a Windovepplication that presents a work environment, which allows
the user to program FLASH memory.
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Menu bar

Commands are grouped into related areas on the Menu bar as indicated by the menu titles. Using the mouse the
user can select a command operation, invoke a dialog box or a window to interact with the system. Clicking the

Figure 2.1 - FDT Graphical User Interface

left mouse button on a menu title will pull down that menu, from which a selection can be made.

If a menu item does not perform an action directly, but instead displays a dialog box or window for further user

interaction, then its name is appended with an ellipsis (three dots, ...).

If a menu item can also be invoked by pressing a hot key (a combination of keys), then the hot key is displayed
to the right of the item.

hda [Etr]
Heda [t
Create Selection... Chrl+i
(Bt [t
[Eapy [ e
Pazte Clrl+
Find... Chi+F
Replace... Clrl+H




If a menu item toggles a feature ON or OFF then a check nfanki(l be displayed next to its text when it is
ON:

Filll.. [Et
| v View ASCI Al
IT Wiew as Bytes Alt+1

Wiew as Words Alt+2

Wiew as Dwords Alt+d

Align to & Bytes Alt+

Download azLUT .ot Ctrl+P

If a menu item has the symbot { next to it then a cascading or hierarchical menu is available. Clicking on the
menu item will reveal the cascading menu:

Open.. Clrl+0
Mew Workspace Clrl+h
Openworkspace... Clrl+hw
Save Workzpace Chl+E

LCloze Workspace

Save Chil+5
Save Az,
Save Al

Cloze File

Fiecent Warkspaces 4
Recent Fj

1 E:ASHAREMEN_BMPhdatal.mot
2 E:ASHAREMEN_BMPhdata mot

E xit T

Menus can also be selected directly from the keyboard by pressiAgThkey followed by the corresponding
key of the underlined letter or number for the menu item that the user wants to select, e.g.

..pressALT+F, O in sequence to open a projdgile->Open)).

Toolbars

The FDT has several toolbars located below the Menu bar. This provides quick access to FDT features by
clicking the respective button with the mouse.

JJI.ﬁ.zimuthEDntmller j|ﬁ| ‘ ﬂ ﬁ ._lf |§3 ﬁ,’ ﬁ ﬂ A
N IR = e

The buttons on each toolbar are arranged in associated groups.

o

e E | #h Ga o

|

To find out the function of the button, move the mouse over the button and a hint will be displayed next to the
button and in the status bar.

The toolbar buttons can be customised to provide a button for the majority of the features available in FDT and
can be arranged in an order that the user finds convenient.

For more details about changing the arrangement of the toolbar buttons and a detailed description of each
button’s function, see chapter@onfiguring the User Interface



Workspace toolbar
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New Workspace
Open Workspac
Save Workspac
New Project

New Workspacelaunches the ‘New Workspace’ dialog box.
Open Workspacelaunches the ‘Open’ dialog box.
Save Workspacesaves the current Workspace.

New Project launches the ‘Project Wizard’ dialog box.



Project toolbar
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Active Project -
Properties
Add S-Record Files
Build Image
Download Device Image
Connect
Disconnect
Erase Blocks
Blank Check
Upload Data
Cancel FL ASH Oneratia

Active Project sets a new active project from those available in the workspace.
Properties- launches the ‘Project Properties’ dialog box.

Add S-Record Fileslaunches the ‘Open’ dialog box so that S-Record files may be added to the project as a
target file.

Build Image- builds the open Device Image file into a binary image file for downloading the target FLASH
memory.

Download Device Imagedownloads the currently open file.
Connect connects the device to the interface.
Disconnect disconnects the device from the interface.

Erase Blocks launches the ‘Erase Block’ dialog box to erase all or individual blocks of the device FLASH
memory.

Blank Check checks whether or not the FLASH section of the target device is blank.
Upload Data- launches the ‘Upload Image’ dialog box to allow data to be obtained from the target device.

Cancel FLASH Operationcancels the FLASH operations Download, Upload and Erase.



Standard toolbar
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Open file

Save file

Save all
Cut

Copy

Paste

Create Selection

Undo
Redo

View as Brtes

View as Words

View as DWords

Toggle ASCII

Align view to 8 lytes

Find

Find and Rplace

Fill selection

Download active file

Open file- launches the ‘Open’ dialog box.

Save file- Saves the current active file.

Save all Saves all files that have not been saved on the Editor window.
Cut- removes the highlighted block to the clipboard.

Copy- copies the highlighted block to the clipboard.

Paste- copies the contents of the clipboard to the window at the cursor position.
Create Selection selects a block of the specified size in the active file.
Undo- reverses the previous editing operation.

Redo- reverses the previous Undo operation.

View as Bytesview the file data as 8 bit bytes.

View as Words view the file data as 16 bit words.

View as DWords view the file data as 32 bit double words.
8



Toggle ASCIF turns ASCII datéDN or OFF

Align view to 8 bytesdata is displayed on each line as 8 bytes. The number of bytes that can be accommodated
on each line is dependent upon the size of the window.

Find - launches the ‘Find’ dialog box.
Find and Replace launches the ‘Replace’ dialog box.
Fill selection- launches the ‘Fill’ dialog box.

Download active file downloads the current active file in the Editor window to the target FLASH memory.
The ‘FLASH Controller’ dialog box will be launched when no files are registered in the project.

Status Bar

The Status Bar is located at the bottom of the FDT application window. It provides the user with information
about what the application is doing or the last action performed.

The left section of the Status Bar describes the action of the Toolbar items as the mouse arrow key is positioned
over an item.

The next section indicates whether the interface is connected to the device and the port used. It also indicates
what action is taking place.

When an action is being performed, the third section gives an increasing percentage display.

The last section of the bar indicates the state of the Caps Lock key.

Pop-up menus

Many windows have local pop-up menus in order to make commonly used features easiastoraese
menus are invoked by clicking the right mouse button in the window (or pré&ddikg+F10) and then
selecting the required menu option. An example pop-up menu is:

(Bt [t
[Eapy [t
Easte g
rd [Eti]
Heds (S
Dizplay Unit 4
Align ta 8 Bytes Ale+8
Create Selection. .. Crl+i
il [t
Find... Chi+F
Beplace... Chrl+H
Froperties... Alt+5Shift+R

The contents and operation of specific pop-up menus are explained in detail in the description of each FDT
window, see the chapter8/indows



Data entry

When entering data in the ‘Find’, ‘Replace’ or ‘Fill’ dialog boxes only hexadecimal or ASCII values can be
used, based on the ASCII Search check box. When entering hexadecimal values a preceding ‘0x’ is fixed in the
entry text box, so hexadecimal values are appended.

2.2 Help

FDT has a standard Windows context sensitive help system. This provides on-line information for using the
system.

Help can be invoked by pressing thtkey orvia the Help menu. Additionally, some windows and dialog
Help

boxes have a dedicated help bul to launch the help file at the appropriate location.

Context Sensitive Help

To get help on a specific item in the FDT graphical interface, a help cursor can be used. To enable the help
cursor presSHIFT+F1.

Your cursor then changes to include a question nk?)( (You can then click on the item for which you require
help and the help system will be opened at the appropriate location, if help information exists. Help can be
invoked through thélelp menu.

2.3 Hot Keys

There are various hot keys for frequently used operations. These are as follows:

Help F1
Open Ctrl+O
New Workspace Ctrl+N
Open Workspace Ctri+W
Save Workspace Ctri+E
Save Ctrl+S
Undo Ctri+zZ
Redo Ctrl+Y
Cut Ctrl+X
Copy Ctri+C
Paste Ctrl+V
Find Ctri+F
Replace Ctrl+H
New Project Alt+N
Add File to Project Ctrl+A
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Build Device Image
Download Device Image
Freshen all Target Files
Properties

Erase FLASH Blocks
Upload Image

Blank Check

Cancel FLASH Operation
Fill

View as ASCII

View as Bytes

View as Word

View as_ DWord

Align to 8 Bytes

Download Image

Ctrl+B

Ctrl+Shift+P

Ctrl+T
Alt+Shift+R
Alt+R
Alt+U
Alt+B
Ctrl+Break
Ctrl+L
Alt+A

Alt+1
Alt+2

Alt+4

Alt+8

Ctrl+P
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3.1 Starting the FDT

To start the FDT, open the ‘Start’ menu of Winddwsd select ‘Hitachi’ from ‘Program’, ‘FLASH

Chapter 3 Basic Operation

Development Toolkit 2.0, and the FDT shortcut. The ‘Welcome to the FLASH Development Toolkit’ dialog

box will open by default.

Welcome to the FLASH Development Toolkit 2 x|

i8]« Eissie snen Woikspace

€ Dpen an existing Workspace

¢ Open an exisiting Image file

akK I Cancel

To create a new workspace, select ‘Create a new Workspace’ and click the ‘OK’ button. To open a recent
workspace, select ‘Open an existing Workspace’ and the workspace to be opened from the list box, and click the

‘OK’ button.

3.2 Creating a New Workspace

(1) Enter the workspace name, then click the ‘OK’ button. (Specify whether or not a directory is to be

created and a location.)

New Workspace 7 x|
Wiorkspace Mame:
Idemd W LCreate work space directorny
Location:
IE:\F’rogram Files\HitachisFDT21 |

Winrkspace file:
C:\Program Filez\Hitachi"FD T2 1%dematdema. fidt

ak. I Cancel |
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(2)  If you want to run the Project Wizard, click the ‘Yes’ button.

FLASH Workspace Manager

2)

(3) Enter the project name, then click the ‘Next’ button.

Project Mame

paroject
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(4) Select the device you wish to use from the drop-down list. If there exists a user-created kernel in addition
to the default path, select ‘Other..." to specify the kernel file (.fcf).

Choose Device And Kernel

The FLASH Development Toolkit supports & number of Hitachi
FLASH devices.

e Select the device you wish to use with this praject from the list
1Akl |

Contygy, Select Device: Cther ... |
i
t ,,lllr_l . Praotocal B
i Canre - Cormilet Hitzchi 6.04
Azl T it kernel Path CProgram FilesHitachiFDT2.1Mernsl
Kernel YWersion q_0_00

4 | i

< Back I Mext » I Cancel |

(5) Select a port and baud rate from the drop-down lists, then click the ‘Next’ button.

Note  For the baud rate, refer to the hardware manual and select a rate where the variance is within 3%.

Communications Port B3

The FLASH Development Toolkit supports connection through
the standard PC Serial port, the USB port and the HMSE JTAG
Development System. Use this page to select your desired
communications port. All settings may be changed after the
project is crested.

Select port: ICOM1 7 l

= The Baud Rate setting specifies a suitable speed for serial

lf‘s.l BT 1 connection bazed on the device characteristics and the Target
PHER Launch Geduen e clock. The default baud rate is set up for use with a standard
HMSE Evalustion Board. If you have a different clock on your
Target vou may need to select a different speed,

[MB - The HWMSE JTAG Development System uses a pre-defined
clock rate)

3167, o
Ex T ot
k. PAC

Select Baud rate:

[~ Use Default Baud Rate

< Back I Mexut » I Cancel

Supplementary:
1. Use Default Baud Rate

Set this option only when the HMSE Evaluation Board is used.
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(6) Enter the numerical values for the input clock, select the main or peripheral multiplier from the drop-
down list, and click the ‘Next’ button.

Device Settings x|

, 1 | SHiIH . 1B | Please enter the specific device options based aon:
n 1 _h .t -
-M | [SHF0SSF] using [Protocol B]
B Mok space T
Gkl Erter the CPU crystal frequenc
ST Al k! Lay b GUEnCY I h 0 oo

v Doy olle for the selected device:
< | |:Ir-\rir_._- I”"'EHF'

A Target files,
2] Mater ©
_:| Azl T I::;' Erter the clock madle for the INONE ,,I

L"..] aZET ot zelected device:
: _i'_T‘i‘ Launch Sequende
L) Device Image

Select the muttinlier for the Main m
- ‘JE'QTJ:;IH o] Elock freguency (CHM):
- N
_:'I zeqENT et
() penbor M soie o the muttiplier for the I__,2 =
A 1] an Peripheral clock frequency
2 04 { (CHPY:

< Back I Hest » I Cancel

Supplementary:

1. CPU Crystal Frequency
Enter the frequency of the CPU clock or the crystal generator as integers or in a format such as xx.xx. You
can only input two digits to the right of the decimal point.

2. Clock Mode
A clock mode needs to be selected depending on the microcomputer. Select a value from the drop-down list.
3. Multiplier for CKM
Select the multiplier of the system clock (master clock) for the input clock.
4. Multiplier for CKP
The frequency rate (CKP) selected depends on the microcomputer. Enter the multiplier of the peripheral
clock for the input clock.

Note To enter the clock mode, input clock, and frequency rate, refer to the hardware manual and confirm the
range to be set.

16



(7)  Select the operating mode, then click the ‘Next’ button. (The interface is ‘Direct Connection’.)

Connection Type

The FLASH Development Toolkit can connect to your device ina

number of different ways. Allthe aptions on this page may be

changed after the Project has been crested.

—Select Connection:
% BOOT pod

£ USER Program Mode

: For BZOT Program mode the Target device erases its FLASH
(=i 22 UT et riot to connection. The Toolkit dovnloads programming kermels

: B] @BV T mol ta the device az required.
g |T| Launch Sequende

& | mage

-1 file Select Irterface: IDirel:‘t Connection 'l

A i, I~ Hernel already residert

. The Target device must be waiting in BOOT SCI mode, the:
0 i) Toolkit will perform the remainder of the boot zequence
automatically.

< Back I Hest » I Cancel

(8) Select the protection level for programming the FLASH ROM and the messaging level, then click the
‘Finish’ button.

Programming Options

The FLASH Development Toolkit offers a device protection
system, pluz an advanced messaging level for uze with
hardware and kernel development.

what level of device protection would you like?
IrProtec:tion

~ Automatic = Mone

When programming the device, you will be asked for
confirmation prior to erasing any previously written blocks.

| Device Imange TR S0 o e gy ] 5 [
- .I.._u- 163k I:Ir Messaging
.'D'l it air, e [G Standard " Advanced

The Toolkit will display messages pertaining to general purpose
0 30 use.

< Back I Firizh I Cancel
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3.3 Saving a Workspace

When the File -> Save Workspacgmenu option is selected, the FDT workspace can be saved.

3.4 Closing a Workspace

Select File -> Close Workspacgto close the FDT workspace. If the workspace or its project is changed, select
Save or Not Save.

3.5 Exiting the FDT

To exit the FDT, selecHjle -> Exit], press the Alt + F4 key, or select the ‘Close’ option from the system menu
(the system menu can be opened by clicking the icon in the upper-left are of the title bar).

3.6 Programming the Data to the FLASH ROM
(1) When the target file (S-Record file) is downloaded:

1. Select Project -> Add Files to Projeci or press the Ctrl + A key to add the file to be downloaded to the
project.

2. Click the right mouse button on the file (*.mot) displayed in the workspace window, and select ‘Download
File to Device'.

3. Programming will be completed when ‘Image successfully written to device’ is displayed in the message log
window.

File Edit Wiew Project Device Image Tools Window Help |
el s EEEEEEE o ==
- ||
'Fr'g ‘Workspace ‘demat 1 Project
E| project]
D Device Image
Ela Taraet files
x|
H
A [+ Dependencies A project] ||_|_|' LI
Far Help, press F1 |Not Connected 4
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(2)  When the device image is downloaded:

1. Add the target file to the project. (Same as item 1 of (1) above.)

2. Click the right mouse button on ‘Device Image’ displayed in the workspace window, and select ‘Build
Device Image’.

3. The creation of the device image is complete when ‘Build Complete — Saving Image..." is displayed in the
message window.

4. Click the right mouse button on the file (*.fpr) displayed in the workspace window, and select ‘Download
Image to Device’'.

5. Programming is complete when ‘Image successfully written to device’ is displayed in the message window.

File Edit Wiew Project Device Image Tools Window Help |
el s [EEEEEEE o ==
=
'Fr'g ‘Workspace ‘demat 1 Project
E| project]
=23 Device Image
L @ project] fpr
=] a Tareet files
i) datal.mot
o[5] data? mot
x|
H
A [+ Dependencies A project] ||_|_|' LI
Far Help, press F1 |Not Connected 4
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3.7 Erasing Data from the FLASH ROM

Select Device -> Erase FLASH blocks.].to display the ‘Erase Blocks’ dialog box.
Select the block to be erased. (When Name of the block is clicked, the block name is inversely displayed.)*
Click the ‘Erase’ button to start erasure.

MooN R

. When ‘Erase complete’ is displayed in the message window, erasure is completed.

Mame | iritten | Start | End | Size
FEE es il ftf 4 K
EB1 Mo 1000 1Hf 4 K
EBZ2 Mo 2000 2fff 4K
EB3 Mo 3000 Bfff 4 K
EB4 Mo 4000 Afff 4 K
EBS Mo Boo0 Bfff 4K
EBG Mo G000 Giff 4 K
EB7 Mo 7000 THf 4 K
EBS Mo 2000 ffff 32K
EBD Mo 10000 1fff 64 K
EE1D Mo 20000 2ifff 6d K
EBT Mo 30000 affff 6d K
EB12 Mo 40000 Affff 64 K
EB13 Mo 50000 Bifff 64 K
EB14 Mo G000 Gifff fid K
EB1E Mo 70000 T fd K
Select All Select Written Eraze | Cancel I

Note To erase all blocks, clicking the ‘Select All’ button inversely displays all blocks. To erase the
programmed block, clicking the ‘Select Written' button inversely displays the target block.

3.8 Reading the FLASH ROM Data

Display the ‘Upload Image’ dialog box frorB¢vice -> Upload Image. .

Enter the start and end addresses.

Click the ‘Upload’ button to start reading.

When ‘Upload operation complete’ is displayed in the message window, reading is complete.

A w PR

Note When the FDT is started in the boot mode, the flash memory data has already been erased.
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Upload Image EE

O FFEfE
0=B0000

¥

_Upoxt | _ Concel |
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Chapter 4 Configuring the User Interface

When the user interface for FDT was designed an attempt was made to make frequently used operations quickly
accessible and have related operations grouped in a logical order. However, when the user is in the middle of a
long session he may find it more useful to have a different arrangement of the user interface items. FDT
facilitates this user customisation. This chapter describes how the user interface can be arranged and how
various aspects of the display can be customised.

4.1 Arranging Windows

Minimising windows

When an operation is finished on an open Editor window but it may be necessary to look at it in its current state
later, it can be reduced to an icon, this is caffédimisingthe window. To minimise a window either click on
the ‘minimise’ button of the window, or seldddinimise] from the window drop-down menu.

The window is minimised to an icon at the bottom of the Editor window.
Note The icon may not be visible if there is another window open over the bottom of the screen.

To restore the icon back to a window either double click on the icon, or click once to pop up the icon menu and
selec{Restore], or select required window from the Menu Patindow] drop-down menu.

Tiling windows

After some time there may be many windows open on the screen. All the windows can be arranged in a tile
format with none of them overlapping each other using the "Tile Windows" option. To invoke this select the
[Window->T ile Windows] menu option.

All currently open windows are arranged in a tile format. Windows that are minimised to icons are not affected.

4.2 Locating Currently Open Windows

When many windows are open in the FDT application window it is quite edéssetone of them behind the
others.

Locating a specific window
There are two methods to find the lost window.

1. To select a specific window, invoke W¢indow] menu. Click on the required window from the list of open
windows at the bottom of the menu. The currently selected window will have a check mark next to it in the
window list.

The window selected will be brought to the front of the display. If it is minimised the icon is restored to a
window.

2. If the[Window->W orkbook View] menu item is checked, a specific window can also be selected by
clicking on the tab containing the file name at the bottom of the Editor window. If the window is not
minimised it will be brought to the front of the display. If it is minimised, the minimised icon will be brought
to the front of the display.
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4.3 Enabling/disabling the Status Bar

The user has the option to enable or disable the Status Bar. By default, the Status Bar is displayed at the bottom
of the FDT application window. To disable the display of the Status Bar, sel¢¢ighe>Status Bar] menu
option.

If the disable option is selected, the Status Bar will be disabled and removed from the FDT application window
display. To re-enable the Status Bar display, seledwileg->Status Bar] menu option again. The Status Bar
will be enabled and added to the FDT application window display and the menu option checked.

4.4 Enabling/disabling the Toolbar

The user has the option to enable or disable the Toolbar. By default, the Toolbar is displayed at the top of the
FDT application window. To disable the display of the Toolbar, sele¢Vibe->T oolbar] menu option.

If the disable option is selected, the Toolbar will be disabled and removed from the FDT application window
display. To re-enable the Toolbar display, selecf¥tiew->T oolbar] menu option again. The Toolbar will be
enabled and added to the FDT application window display and the menu option checked.

4.5 Enabling/disabling the Workspace

The user has the option to enable or disable the Workspace. By default, the Workspace is displayed. To disable
display of the Workspace, select {Mew->Workspace] menu option.

If the disable option is selected, the Workspace will be disabled and removed from the FDT application window
display. To re-enable the Workspace display, seledMieg->W orkspace]menu option again. The
Workspace will be enabled and added to the FDT application window display and the menu option checked.

4.6 Enabling/disabling the Message Log

The user has the option to enable or disable the Message Log. By default, the Message Log is displayed. To
disable display of the Message Log, selec{¥iew->M essage loginenu option.

If the disable option is selected, the Message log will be disabled and removed from the FDT application
window display. To re-enable the Message log display, seleffigne->M essage loginenu option again. The
Message log will be enabled and added to the FDT application window display and the menu option checked.

4.7 Enabling/disabling the Dependency Log

The user has the option to enable or disable the Dependency Log. By default, the Dependency Log is displayed.
To disable display of the Dependency Log, selecf\ffew->Dependency LogJmenu option.

If the disable option is selected, the Dependency Log will be disabled and removed from the FDT application
window display. To re-enable the Dependency Log display, selepfithe->Dependency LogJmenu option

again. The Dependency Log will be enabled and added to the FDT application window display and the menu
option checked.

24



4.8 Customising the Toolbar

The selection and arrangement of buttons displayed on the Toolbar can be customised to suit a user’s
requirements. To change the display invoke[TiomIs->Customise...Jmenu option.

The ‘Customise FLASH Development Toolkit’ dialog box will be displayed:

Customise FLASH Development Toolkit x|

Toolbars |C0mmands| Dutput Window | General |

Toolbars:

el ¥ Shaw Tooltips New. .

[w]'workspace ™

ot v Cool Look T

[w]Standard [~ Large Buttans

151k

(ke[ e =

Menu bar

ak. I Cancel

The ‘Customise FLASH Development Toolkit’ dialog box has four tabs, Toolbars, Commands, Output Window
and General, which are further described in chapter 6, Windows.

Toolbars

The Toolbars tab allows the user to select a group (e.g. workspace) and to select the functions for that group.

A check mark in th&how Tooltipsbox indicates that the action of the button will be displayed when the mouse
arrow is pointing to the button. If the box is unchecked no action is displayed.

A check mark in th€ool Look box removes the border around all menu and toolbar items. If the box is
unchecked the borders are present.

If the Large Buttons box is checked, the size of the buttons is increased.

TheNew... button launches the ‘Toolbar Name’ dialog box which allows the user to name and generate a new
toolbar. After entering the new name and clickingdi, the new name will be added to the Toolbars list and
an empty toolbar is displayed on the interface.

Selecting the Commands tab allows the user to select and add buttons to the new toolbar. The user can place the
new toolbar anywhere on the GUI by dragging it with the mouse.

When a user created toolbar is selected in the Toolbars liRes®tbutton is renamed telete Clicking on
this button will remove the new toolbar from the list and from the GUI.

TheResetbutton resets the selected toolbar to its default settings.
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Commands

This tab shows the buttons and describes the action for each button in each group and allows the user to
customise the toolbar according to an individual application.

Clicking on an item in th€ategoriesbox displays the buttons available for that category.
TheButtons area displays a picture for each button in the selected category.

To obtain a description of the action of a button, click on that button. The description will appear in the
Description area.

Adding a button to the Toolbar
< To add a button to the Toolbar:

1. Select the button from the appropriate category, by pointing the mouse pointer at the
button and press the left mouse button.

2. Drag the button to the required position in the Toolbar.

3. Release the mouse button.

Positioning a button in the Toolbar
< To move a button position in the Toolbar order:
1. Select the appropriate button on the Toolbar to move with the mouse as above.
2. Drag the button to the required position on the toolbar.

3. Release the mouse button.

Removing a button from the Toolbar
< To remove a button from the Toolbar:
1. Select the button with the mouse as above.
2. Drag the button to the ‘Customise FLASH Development Toolkit' dialog box.

3. Release the mouse button.
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Chapter 5 Menus

This document follows the standard Microsoft menu naming convention:

7 FLASH Development Toolkit [Supported] - Rocket Launcher M=
Menu#ile Edit Yiew | Project Device Image Tools Window Help |

Bar :
Menu New Project... Al _

Title Add Files ta Project... Clrl+&, Cascading Menu
BRemaove File from Project... Clrl+R

Drop-down v Azimu[h Controlles

Menu Ins=rt Project... | Launch Sequencer |
Build Device |mage Chil+B L Check Mark

Menu Option —————rmmminad Device Imane il 5 hift+
FEreshen all Target files Chrl+T
Properties. .. Alt+Shift+R

Ellipse ——— | \— Hot Key

5.1 File

The ‘File’ menu is used for aspects of the program that access data files.

Open...

Launches the ‘Open’ dialog box allowing the user to open an existing file. The file may be an S-Record file
(.rec, .mot, .a20, .a37), a Device Image file (.fpr) or a FDT Workspace file (.fdt).

New Workspace

Launches the ‘New Workspace’ dialog box allowing the user to specify the name and location of a new
workspace and creates a new workspace directory.

Open Workspace...

Launches the ‘Open’ dialog box allowing the user to open an existing FDT Workspace file (.fdt).

Save Workspace

Saves the details of the currently active Workspace.

Close Workspace

Closes the currently active Workspace.

Save

Saves the current active file.
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Save As...

Launches the ‘Save As’ dialog box allowing the user to save and name the uploaded DEVICE Image file with a
fpr extension, or if an S-Record file is active to rename and save that file.

Save All

Saves all files that have not been saved on the Editor window.

Close File

Closes the current active file.

Recent Workspaces

Provides a cascaded menu listing recently used workspaces allowing the user to select one.

Recent Files

Provides a cascaded menu listing recently used files allowing the user to select one.
Exit

Closes and exits the FDT application.

5.2 Edit

The ‘Edit’ menu is used for aspects of the program that access or alter data in the Editor window.

Undo

Allows the user to reverse the previous editing operation.

Redo

Allows the user to reverse the previous Undo operation.

Create Selection...

Launches the ‘Create Selection’ dialog box allowing the user to create a selection area by entering its start
address, end address and length. The selected area can be used in conjunction wittodrel GHill or Search
and Replace.

Cut

This will remove the contents of the highlighted block from the window and place it on the clipboard in the
standard Windows manner. This option is only available if a block is highlighted.

Copy

This will copy the contents of the highlighted block to the clipboard in the standard Windows manner. This
option is only available if a block is highlighted.
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Paste

This will copy the contents of the Windows clipboard into the child window at the current cursor position.

Find...

This will launch the ‘Find’ dialog box allowing the user to enter either hexadecimal or ASCII data. The scope of
the search is bounded by the area selected, for the active file in the Editor window. If a match is found, the
Editor window is updated to display the found data.

Replace...

This will launch the ‘Replace’ dialog box allowing the user enter either the hexadecimal or ASCII data to be

found and the replacement data, in the same format. The scope of the search is bounded by the area selected, for
the active file in the Editor window. If a match is found, the Editor window is updated to display the found data,
click on the now enableBeplacebutton to replace the data.

5.3 View

The ‘View’ menu is used to display or remove FDT GUI features, such as displaying child windows and
toolbars.

Toolbar

Toggles the toolbar feature on and off. If the feature is active then a check mark will be displayed to the left of
the menu text.

Status Bar

Toggles the status bar feature on and off. If the feature is active then a check mark will be displayed to the left of
the menu text.

Workspace

Toggles the Workspace on and off. If the feature is active then a check mark will be displayed to the left of the
menu text.

Message Log

Toggles the Message Log on and off. If the feature is active then a check mark will be displayed to the left of the
menu text.

Dependency Log

If this item is checked, the Dependency Log is available as a tab for the Output window.

5.4 Project

The ‘Project’ menu provides high level control and facilities for projects within the workspace.
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New Project...

Launches the ‘Project Wizard’ dialog box allowing the user to create a new project and enter any comments.
When an FDT project is created all its project details are maintained in a project file. The project file is named
after the project with a file extension of .cpj.

Add Files to Project...

Launches the ‘Open’ dialog box allowing the user to add S-Record files (.rec, .mot, .a20, .a37) to the project.

Remove File from Project...

Removes the selected file from the project.

Set Active Project

Provides a cascaded menu listing projects within the currently open workspace allowing the user to designate
one as the active project.

Insert Project...

Launches the ‘Open’ dialog box allowing the user to open FDT created Projects (.cpj files).

Build Device Image

Builds the target files into a binary image file (Device Image) for subsequent downloading to the target FLASH
memory.

Download Device Image

Loads the open Device Image file into the target FLASH memory.

Freshen all Target files

Updates the files contained in project to the current contents of their original source files.

Properties...

Launches the ‘Project Properties’ dialog box for the current project. This dialog box contains seven tabs -
Project, Kernel, Communications, Device, Programmer, Modules and Comments.

5.5 Device

The ‘Device’ menu provides control facilities for interacting with the target device.

Connect to Device/Disconnect from Device

This connects the GUI to the device if it is not connected or disconnects if it is connected. Messages will appear
in the Message log if the connection can not be made. The Status Bar will indicate whether or not the device is
connected.
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Erase FLASH blocks...
This launches the ‘Erase Blocks’ dialog box.

The ‘Erase Blocks’ dialog box allows the user to specify which blocks are to be erased. The Written column
indicates whether data is present in the block.

To start the operation, select the required block names in the list and then cicagabutton.

Note Whilst blocks that contain no data need not be erased, FDT will erase all specified blocks.

Upload Image...

This launches the ‘Upload Image’ dialog box, which enables the uploading of a range of data from the target
device. This is intended for access with FLASH memory. The data is placed in the Editor window.

Blank check

This launches a blank check on the device FLASH and reports back both to the Message log and a status
window.

Download ‘file name’

This downloads the current active file into the target FLASH memory.

User Boot Area

This menu is enabled for the 0.18-um device. When User Boot Area is selected (enabled), the FDT specifies to
write the data to the flash ROM area, to upload image and to check blank in the user boot area of the 0.18-um
device.

Cancel FLASH Operation

Cancels the current FLASH operations of Download, Upload and Erase, if they are active.

5.6 Image

The ‘Image’ menu provides facilities for displaying and maintaining the contents of the active file in the Editor
window.

Fill....

Launches the ‘Fill’ dialog box for the currently active file, allowing a selected area to be filled with the specified
data. The data to be filled can be an ASCII character viASi@| Fill check box.

View ASCII

Toggles the ASCII representation of the dataandOff.

View as Bytes

Allows the user to view the data as 8 bit bytes.
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View as Words

Allows the user to view the data as 16 bit words.

View as DWords

Allows the user to view the data as 32 bit double (long) words.

Align to 8 Bytes

Data is displayed on each line as 8 bytes. The number of bytes that can be accommodated on each line is
dependent upon the size of the window.

Download ‘file name’

Downloads the current active file into the target FLASH memory.

5.7 Tools

The ‘Tools’ menu is used to launch additional FDT features, which are not related to either projects or target
devices.

Simple Interface...

Writes the created project to the flash memory by using one button.

UPB Diagnostics...

(Feature not currently available)

JTAG Development System...

(Feature not currently available)

Advanced Configuration...

(Feature not currently available)

Kernel Build Assistant...

(Feature not currently available)

Customise...

Launches the ‘Customise FLASH Development Toolkit' dialog box allowing the user to customise the toolbar
and commands.

5.8 Window
The ‘Window’ menu is used to alter the display of currently open windows within the FDT GUI. Files displayed

in the Editor window are appended to the following list, these files are identified by their filename and the
currently active file is denoted by check mark.
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Workbook View

If the Workbook View is checked, tabs for each current window are located at the bottom of the Editor
window. If it is unchecked the tabs are hidden. Clicking on a tab will make that file active.

Docking Views

With this option checked the Workspace window and the Editor window are positioned side by side. With the
option unchecked the Editor window is positioned behind the Workspace window. Clicking on a window will
bring it to the top of the display.

Tile Windows

Arranges the child windows in the standard tile manner, i.e. each window is sized such that all are displayed
without overlapping.

‘file name’

This option becomes active when a file name is selected and checked.

5.9 Help

The ‘Help’ menu is used to access additional information on how to use the functionality provided by FDT.

Help Topics

Launches the Help system for FDT. The ‘Help Topics’ dialog box for FDT is displayed, enabling help to be
accessed on required FDT subjects through several methods.

About...

Launches the ‘About FLASH Development Toolkit’ dialog box, through which additional information
regarding FDT can be accessed:

« FDT version.

« Library descriptions, build dates and versions for each of the FDT components.
¢ FDT supported devices.

¢ FDT supported communication interfaces.
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Chapter 6 Windows

This chapter describes each child window type, the features each supports and the options available through
their associated pop-up menus.

There are three main windows - Workspace window, Editor window and Output window.

Most windows have local pop-up menus in order to make commonly used features easiesstoraese
menus are invoked by clicking the right mouse button within the window (or pr&dikrg+F10) and then
selecting the required menu option.

Windows may also be launched from a number of the main menu items.

6.1 Workspace window

The Workspace window contains details of the items in the workspace including the workspace name, projects
contained in the workspace and for each project their Device Image files and Target files.

Lz

Alncher .

[=]= L Lal
uth Controller
B9 Device Image
ﬁ Azimuth Controller. fpr
23 Target files

L5 el mat

Loz azENT.mot

-- Launch Sequencer

v Docking View
Hide:

Invoking certain menu items from a pop-up menu in the Workspace window will launch additional windows.

The Workspace window pop-up menu has the following items:

Docking View

With this option checked the Workspace window and the Editor window are positioned side by side. With the
option unchecked the Editor window is positioned behind the Workspace window, such that the Workspace
window is a floating window. Clicking on a window will bring it to the top of the display.

Hide

Invoking Hide occults the Workspace window. It is restored\digw->W orkspace]
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6.2 Workspace

The Workspace is the first item in the window, in the following example this is “Workspace ‘Rocket
Launcher™:

| Azimuth Controller Mew Project...
=3 Device Image Inzert Project into ‘Workspace. .
LA Azimuth Contraller for
123 Target files Open‘Workspace... Clrlas
: - azLUT.mot Save wWorkzpace Chrl+E
(5] azEWT.mat Close Workspace
BEH Launch Sequencer
Properties. .. Alt+Shift+R

The pop-up menu for Workspace has the following items:

New Project...

Launches the ‘Project Wizard’ dialog box allowing the user to create a new project and enter project comments.

Insert Project into Workspace...

Launches the ‘Open’ dialog box allowing the user to insert an existing project into the Workspace.

Open Workspace...

Launches the ‘Open’ dialog box allowing the user to open an existing FDT Workspace file (.fdt). This will close
an open Workspace and load the specified replacement.

Save Workspace

Saves the details of the current workspace and its project(s).

Close Workspace

Closes the current workspace.
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Properties...
Launches the ‘Workspace Properties’ dialog box which shows the following details:

« the Workspace Name,

« its filename and path,

« the time and date when the workspace was last saved,
« if the workspace has been modified and not yet saved,
« the number of projects in the workspace,

« the name of the current active project.

6.3 Project

The Project is the next item in the hierarchy below the Workspace. In the following example, both “Azimuth
Controller” and “Launch Sequencer” are Project names.

=l
Wwhorkspace 'Rocket Launcher' 2 Projects

E| Azimuth Controllg

E‘a Device Image Add Files to Project...

o LR Azimuth Con Set as Active Project

E‘a Target files Remove Project
2] azlUT. mot

5] azENT mat LConnect to Device
-- Laurch Sequencer Erase FLASH blocks...
Upload Image. ..
Blank check.

[Fanee] LS EH I peratian

Build Device Image

Freshen all T arget files

Froperties. .. Alt+5hift+R

The pop-up menu for Project has the following items:

Add Files to Project...

Launches the ‘Open’ dialog box allowing the user to add S-Record files to the project.

Set as Active Project

Sets the highlighted project as the active project.

Remove Project

Remove the highlighted project from the Workspace.

Connect to Device / Disconnect

This connects the GUI to the device if it is not connected or disconnects if it is connected. Messages will appear
in the Message log if the connection can not be made. The Status Bar will indicate whether or not the device is
connected.
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Erase FLASH blocks...
This launches the ‘Erase Blocks’ dialog box.

The ‘Erase Blocks’ dialog box allows the user to specify which blocks are to be erased. The Written column
indicates whether data is present in the block.

To start the operation, select the required block names in the list and then cicagabutton.

Note Whilst blocks that contain no data need not be erased, FDT will erase all specified blocks.

Upload Image...

This launches the ‘Upload Image’ dialog box, which enables the uploading of a range of data from the target
device. This is intended for access with only FLASH memory. The data is placed in the Editor window.

Blank check

This launches a blank check on the device FLASH and reports back both to the Message log and a status
window.

Cancel FLASH Operation

Cancels the current FLASH operations of Download, Upload and Erase, if they are active.

Build Device Image

Builds the target files into a binary image file (Device Image) for subsequent downloading to the target FLASH
memory.

Freshen all Target files

Updates the files contained in project with the current contents of their original source files.

Properties...

Launches the ‘Project Properties’ dialog box for the current project. This dialog box contains seven tabs -
Project, Kernel, Communications, Device, Programmer, Modules and Comments.
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6.4 Device Image - Sub Folder

This contains the Device Image file the project.

=l
Workspace 'Rocket Launcher’ 2 Projects
El Azmuth Controller

Build Device Image

= a T arget files Ereshen all T arget files

LUT.
ZEEW : Erameiifzs.. Alt+Shift+R

l Launch Sequencer

The Device Image - Sub Folder pop-up menu has the following items:

Build Device Image

Builds the target files into a binary image file (Device Image) for subsequent downloading to the target FLASH
memory.

Freshen all Target files

Updates the files contained in project with the current contents of their original source files.

Properties...

Launches the ‘Project Properties’ dialog box for the current project. This dialog box contains seven tabs -
Project, Kernel, Communications, Device, Programmer, Modules and Comments.

6.5 Device Image - Sub-Project Properties

With the ‘Project Properties’ dialog box invoked from the Device Image - Sub Folder pop-up menu, clicking the
left mouse button will launch the ‘Sub-Project Properties ‘Device Image” dialog box.
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6.6 Target files - Sub Folder

This contains the S-Record files for the project that will be used to build the Device image.

T
‘Workspace 'Rocket Launcher: 2 Projects
E|-- Azimuth Controller
=23 Device Image

- ﬁ Azimuth Contraller fpr

Add Files to Project...
Ereshen all T arget files

=]
Launch Seq

Properties... Alt+Shift+H

The Target files - Sub Folder pop-up menu has the following items:

Add Files to Project...

Launches the ‘Open’ dialog box allowing the user to add S-Record files to the project.
Freshen all Target files

Updates the files contained in project with the current contents of their original source files.
Properties...

Launches the ‘Project Properties’ dialog box for the current project. This dialog box contains seven tabs -
Project, Kernel, Communications, Device, Programmer, Modules and Comments.

6.7 Target files - Sub-Project Properties

With the ‘Project Properties’ dialog box invoked from the Target file - Sub Folder pop-up menu, clicking the
left mouse button will launch the ‘Sub-Project Properties ‘Target files” dialog box.
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6.8 Device Image

The Device Image is the item contained in Device Image - Sub Folder. In the following example, “Azimuth
Controller.fpr” is the Device Image file for the project “Azimuth Controller”.

=
Wwhorkspace 'Rocket Launcher' 2 Projects
E-EH Azimuth Controller

! Ea Device Image

Ea T arget files Edit
azLT.mat Bemove File from Project
5] azEWT.mat Block usage...

-- Launch Sequencer
Bebuild Image

Download Image to Device

Froperties... Alt+5Shift+R

The pop-up menu for Device Image has the following items:

Edit

Displays the Device Image file in the Editor window to allow the user to carry out modifications.

Remove File from Project

Removes the device image file from the project.

Block usage...

Launches the ‘Device Image Properties’ dialog box and displays the Block usage tab.

Rebuild Image

Rebuilds the binary image file (Device Image) with its constituent target files, for subsequent downloading to
the target FLASH memory.

Download Image to Device

Downloads the Device Image to the device FLASH memory.

Properties...

Launches the ‘Device Image Properties’ dialog box. This contains three tabs - File properties, Dependencies and
Block usage.
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6.9 S-Record Files

S-Record files are the items contained in Target files - Sub Folder. In the following example, both “azEVT.mot”
and “azLUT.mot" are target files for the project “Azimuth Controller”.

=l
wiorkspace Rocket Launcher’ 2 Projects
E-E2l Azimuth Controller
| B4 Device Image

”E,'] Azirmuth Controller. fpr

223 Target files

Edit
-- Launch Sequenc Bemarve File from Project
Download File to Device

FEreshien lozal Fie
Properties... Alt+Shift+H

Each S-Record file pop-up menu has the following items:

Edit

Displays the S-Record file in the Editor window to allow the user to carry out modifications.

Remove File from Project

Removes the selected S-Record file from the project.

Download File to Device

Downloads the selected S-Record file to the device FLASH memory.

Freshen Local File

Updates the files contained in project with the current contents of their original source files.

Properties...

Launches the ‘S-Record Properties’ dialog box. This contains three tabs - File properties, Dependency and
Block usage.

6.10 Workspace Properties
Invoked from the Workspace pop-up menu iteroperties....
The ‘Workspace Properties’ dialog box shows details of:

« the Workspace Name,

« its filename and path,

« the time and date when the workspace was last saved,
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« if the workspace has been modified and not yet saved,
« the number of projects in the workspace,
« the name of the current active project.

b L autcher'

Workspace properties |

Property | Walus

YWiorkspace Mame  Rocket Launcher

Filename EAFOTSProjectFiletRocket Launcher Rocket Launcher. fdt
Last saved 16:26:08 14/03402

Currently modified Mo
Murnber of Projects 2
Active Project Azirmuth Cantraller

6.11 Project Properties

The ‘Project Properties’ dialog box can be invoked fromPtaperties... item of the pop-up menus in Project,
Device Image - Sub Folder, Target files - Sub Folder, and also the mair[Pnejact->Properties...].

(1) Project

This shows the name of the project, the location and the filename of the project file, its creation date and time,
and also the target device and configuration file.

Project |Kernel| Communicationsl Devicel F'rogrammerl Modulesl Comments

Property | Walue -

Froject Hame  Azimuth Contraller

Location EMNFDT ProjectFiletRocket Launcherdzimuth Controller
Filename Azimuth Contraller cpj

Creation Time  20:47:28  01/08/01

Target Device SH/TF0RSF

I:Tnfia File C:%Proaram Files\HitachisFDT 2.1 \Kernels'\F‘rotB\?DEE‘\hitachi'\i 1] DEIE'LI

4
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(2) Kernel

This shows the frequency, protocol, multiplier, and clock mode.

zirnuth Controller

Project  Kemel | Communicationsl Devicel F'rogrammerl Modulesl Comments

Property | Walue
Frequency 1000
Pratacol B
CEM Multiplier 4
CEP Multiplier 2
Clock Mode 0

(3) Communications

This shows the default and current baud rates and the current port. It also allows the user to change the Port and
Baud Rate.

nuth Controllert

Froject | Kemel Communications | Devicel F'rogrammerl Modulesl Commentsl

e | [
Currently connected Mo IW 'I

V¥ Use default baud

Target Baud R ate:
|384DU 'l

COM Port

This drop-down list provides the user with a list of supported COM ports available for connection to the device.

Use default baud

If this is checked, the default Baud Rate will be used. (This option should be set only when HMSE Evaluation
Board is used.)

Target Baud Rate

If the Use default baud is unchecked, the Target Baud Rate provides a drop-down list of Baud Rates between
2400 and 115200 bits/s for the user to select.
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(4) Device

This shows the device information. It also allows the user to $@0T Mode or USER Program Modeand
the ‘Direct Connection’ interface. In addition, it can specify whether or not the kernel is in the target device.

nuth Controller'

F'loiectl Kemell Communications Device | F'rogrammerl Modulesl Comments

Property | Value | Connection——
Device Mame  SH/TO55F & BO0T Mode
Rat Size 32K ¢ IUSER Program Mode
FLASH Size 512K Select Interface:

IDirect Connection j

™ Kemel aready resident

BOOT Mode

This connection type specifies that the on-board programming BOOT mode sequence is to be initiated if a
kernel cannot be found running on the target device. This will cause the entire FLASH memory to be erased and
a kernel loaded.

If a kernel is already resident the FLASH is not erased, rather information regarding the block usage is obtained
to help prevent accidental overwriting.

USER Program Mode

This connection type specifies that the on-board programming USER Program mode sequence is to be initiated
by a previously loaded user program that is used to reprogram the FLASH memory.

Select Interface

Only the ‘Direct Connection’ interface is available.

Kernel already resident

This check box is specified when a kernel is already resident on the target device.
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(5) Programmer

This shows the state of the Function Map and allows the user to select the Device Protection Option of
Automatic, Interactive, or None and the message level option of Advanced or Standard.

F'loiectl Kemell Eommunicationsl Device Frogrammer | Modulesl Commentsl

Function map Ophiong
wirite Mat loaded Device protection:
Read Mot lnaded IM vl
Eraze Mot lnaded
Blank Check.  Mat lnaded Message level:
Data Buffer  Mone I
Advanced j
0 Eptes Available

Device Protection

This allows the user to select either automatic protection (Automatic) or interactive protection (Interactive) to
protect the FLASH device from accidental over-erasure and over-programming. Automatic protection will erase
blocks from the device prior to programming, as necessary. Interactive protection will ask the user before an
erase occurs. The FDT can be forced to write to a block containing data. In addition, None can be selected to
disable device protection.

Whilst connected to a device FDT keeps track of the state of the FLASH blocks and is able to determine when a
programming operation will over-program a region of FLASH memory.

Note If device protection is disabled the user is responsible for erasing the device prior to programming.

Message level

The user can select either Standard or Advanced message levels. A Standard message level generates general
FDT/target device status messages regarding high-level communications details. An Advanced message level
generates more detailed information regarding lower level communications details.
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(6) Modules

This shows each Kernel file name.

uth Controller’

F'roiectl Kernell Communicationsl Devicel Programmer  hodules |Comments|
Madule | Path |=
BOOT Mode Mico Kemel  wGens088r cde
BOOT Mode Kemel Genm?055.cde
USER Mode Kemel Genu?055.cde
Read
ik Gerw 055, cde o
Blank Check
Erase Gene?055 cde LI

(7) Comments

This allows the user to insert any project comments. Clicking with the right mouse button provides a drop-down
menu for editing facilities.

F'loiectl Kemell Eommunicationsl Devicel Programmer | Modules  Comments

This project programs the Azimuth microcontroller.
Undo
[oulf
[Sapy
Easte
DElete

Select All

Undo

Reverses the last edit operation in the Comment window.

Cut

Removes the selected text in the Comment window and places it in the Winclipksard.

Copy

Copies the selected text in the Comment window to the Wirfdoligghoard.

Paste

Pastes the contents of the WindOwipboard into the Comment window at the cursor position.

Delete

Deletes the selected text in the Comment window.
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Select All

Selects all the text in the Comment window.

6.12 Device Image Properties

Invoked from the Device Image pop-up menu item ‘Propertie

(1) File properties

The ‘Device Image Properties’ dialog box shows details of the Device Image location and its flename, the time
and date the image file was last saved, if the image file has been modified and not yet saved, if the image file is
currently open in the Editor window, and also the FLASH memory size.

zimuth Controller. fpr'

File propetties | Dependencies | Block usage

Property | Yalue

Location E:\FD T ProjectFile' R ocket Launcherdzimuth Contraller
Filename Azimuth Contraller fpr

Last zaved Unable to open file

Proceszed Mo

Currently open Mo

(2) Dependencies

This shows the S-Record files and their status associated with the Device image.

Device Image Propert

File properties  Dependencies | Block usage

File | Status | The Device Image iz out of
azLUT.mat Mo Dependency date
azEWT.mot Mo Dependency

Febuild Maw |

Rebuild Now

If the device image is out of date as indicated by the general device image status message, it can be rebuilt by
clicking on this button.
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(3) Block usage

This shows the starting, finishing address and sizes of the blocks contained in specified file.

imuth Controller fpr'

File propertiesl Dependencies  Block usage

HO0000000 - 000U FFEE | Lenath ;. HIOOOA0000




6.13 S-Record Properties

The ‘S-Record Properties’ dialog box is invoked from the S-Record pop-up menu item ‘Properties..." and the
Editor window pop-up menu option ‘Properties...” and contains three tabs:

(1) File properties

The ‘S-Record Properties’ dialog box shows details of the S-Record filename and its location, the time and date
the file was last saved, if the file has been modified and not yet saved, and also if the file is currently open in the
Editor window, and also the FLASH memory size.

zLUT. mat'
File propetties | Dependency I Block usage I
Property | Walue -
Location E:\FD T ProjectFile' R ocket Launcherdzimuth Contraller
Filenarme azL T . mat
Last zaved 174510 01./08/01
Proceszed Tes
Currently open Mo |
Modified Mo
Size 512K hd|

(2) Dependencies

This shows the S-Record File, whether it has dependencies, and if it has, the Dependency path. Clicking on
Change...launches thépen’ dialog box that allows the user to select a new path. The Dependency tab also
shows if the S-Record file is up-to-date and when the file and the Dependency were last modified.

zLUT. ot

File properties  Dependency | Block uzage

File : azLUT.mat Last modified:

174510 01/08/0
¥ Has Dependency

Dependency path Last madified
: ast modified;
ID.\fdt\azLLIT.mot Ehange...l 174510 D1 /08/01

The local copy of 'azLUT . mot' is up to date.
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(3) Block usage

This shows the starting, finishing address and size of the blocks contained in specified file.

File propertiesl Dependency Block uzage

HOOO00000 - HO000007E - Lenath ;. HOOOO0080

6.14 Output Window

The Output window is one of the main windows contained in the FDT GUI.

=|
I
LCopy

Clear Messages
Save Meszages...

v Allow Docking
Hide

4] *T'. Dependencies }, Azimuth Controller £ Caunch Sequencer / IENNE I

For Help, press F1 |Mot Cornected [ 4

The window has available pop-up menu that contains the following items:

Copy

Copies the contents of the active log to the Windoslipboard.

Clear Messages

Clears the active log.

Save Messages...

Launches the ‘Save As’ dialog box allowing the user to save the contents of the active log in the Output window
as a .txt file.

Allow Docking

With this option checked the Output window is capable of being docked within the FDT application window.
With the option unchecked the Output window is a floating window.
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Hide

Invoking Hide occults the Message log. It is restoredWigw->M essage log]
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6.15 Editor Window

The Editor window is one of the main windows contained in the FDT GUI.

File Edit \iew Project Device Image Tools Window Help |
00000000 00 01 02 03 04 05 06 07 08 09 Oa Ob Oc Od Oe 0f 01 02 03 . =
00000013 04 05 06 07 08 09 Da Ob Oc Od Os Of 10 02 03 04 05 06 07 N P
00000026 08 09 Oa Ob Oc Od Os 0f L0 11 03 04 05 06 07 08 09 0= Ob . 0............ ..1
00000039 Oc 0d Oe Of 10 11 12 04 05 06 07 08 09 Oa Ob Oc Od O Of 1
0000004c 10 11 12 13 05 06 07 08 09 Oa Ob Oc Od Os Of 10 11 12 13 I
0000005 14 06 07 08 09 Oa Ob Oc Od Oe Of 10 11 12 13 14 15 07 08 -
00000072 09 0a Ob Oc Od 0= 0Of 10 11 12 13 14 15 16 08 09 Oa Ob Oc 1
00000085 0d Oe Of 10 11 0f 10 P
00000098 11 12 13 14 15 bt Cinlpit 13 14
000000ab 15 16 17 18 19 ey ik 17 18

000000be 19 la Oc 0d Os ib 0d

D00DODAL Oe 0F 10 11 12 | - N TR

000000=4 12 13 14 15 16 14 15

000000E7 16 17 18 19 la Lnds GirlZ 18 19

0000010a 1a 1b lc 1d le Fedo il ic 14

0000011d  1le 1f 20 12 13

nonoo130 13 14 15 16 17 it

00000143 17 18 19 la 1b

00000156 1b 1c 1d 1= 1f Gllign o ) e lt

00000169 1f 20 21 22 23

noo0ol7e 23 24 25 26 1% Create Selection.. Cirk+M

0000018f 27 19 la 1b 1c il Girlrl .
000001a2 1c 1d le 1f 20 B Bl E le 1€ ... 1U#SHE().. ...
000001bE 20 21 22 23 24 el i 22 23 IUESuA ()%, .. "#
nonnoice 24 25 26 27 28 Replace.. Gtrl+H 26 27 &uh()w+ I Er
000001db 28 29 2a 2b 2c 2a 2b ()R, .. | UESHE )R+
000001ese 2o 2d 1f 20 21 Properties.. Al+Shift+R 22 20— DUESHE(JE4y, —
00000201 21 22 23 24 25 = 23 24 1UESHE ()w+.— S1#S
00000214 25 26 27 28 29 2a 2b 2c 2d 2e 2f 30 22 23 24 25 26 27 2B %&' ()%+, — o0 #SHE
0000227 29 Za ?h 20 2d Ze 2f 30 31 23 24 25 26 27 28 29 Za b 2o )%+, - SOT#SHE' )%+
00000232 2d 2 2f 30 31 32 24 25 26 27 28 29 2a 2b 2c 2d 22 2f 30 - ~0128%& ()% - -0 x|
demao.mot

The window has available pop-up menu that contains the following items:

Cut

This will remove the contents of the highlighted block from the window and place it on the clipboard in the
standard Windowsmanner. This is only available if a block is highlighted.

Copy

This will copy the contents of the highlighted block to the clipboard in the standard Wihdwwmsier. This is
only available if a block is highlighted.

Paste

This will copy the contents of the WindoWslipboard into the child window at the current cursor position.

Undo

Reverses the last editing operation on the selected data.

Redo

Reverses the last undo operation.
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Display Unit

Invokes the cascaded menu as follows:
Byte- view the data as 8-bit bytes.
Word - view the data as 16-bit words.

DWord - view the data as 32-bit double words.

Align to 8 Bytes

Data is displayed on each line as 8 bytes. The number of bytes that can be accommodated on each line is
dependent upon the size of the window.

Create Selection...

Launches the ‘Create Selection’ dialog box allowing the user to create a selection area by entering its start
address, end address and length. The selected area can be used in conjunction wothotrel Gill or Search
and Replace.

Fill....

Launches the ‘Fill’ dialog box for the current active file to write the specified data to the selected area. When the
‘ASCII Fill' check box is selected, the data to be written can be specified with ASCII characters.

Find...

This will launch the ‘Find’ dialog box allowing the user to enter either hexadecimal or ASCII data. The scope of
the search is bounded by the area selected, for the active file in the Editor window. If a match is found, the
Editor window is updated to display the found data.

Replace...

This will launch the ‘Replace’ dialog box allowing the user enter either the hexadecimal or ASCII data to be

found and the replacement data, in the same format. The scope of the search is bounded by the area selected, for
the active file in the Editor window. If a match is found, the Editor window is updated to display the found data,
click on the now enableeplacebutton to replace the data.

Properties...

Launches the ‘S-Record Properties’ dialog box.
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6.16 Erase Blocks

Invoked by[Device->Ease FLASH blocks...] the Workspace Project pop-up menu iterase FLASH
blocks..., the ToolbaiErase Blocksand theErase FLASH blocks...command from the FLASH Controller.

The ‘Erase Blocks’ dialog box allows the user to specify which blocks to erase. The Written column indicates
whether data exists in the block.

Eraze Blocks
Hame | Written | Start | End | Size |
EEOD Mo 1] ff 4K
EB1 Mo 1000 iliis 4k
EBZ2 Mo 2000 2fif 4k
EB3 Mo 3000 Kiiis 4k
EE4 Mo 4000 i 4k
EES 1] 5000 Gt 4F.

EEE Mo EO00 =i 4F.

EEY Mo Fo0o i 1K

EES Mo g00o i 2K
EE3 Mo 10000 iliii} B4k
EE10 Mo 20000 i} B4 K
EB11 Mo 30000 i} B4 K
EEB12 Mo 40000 Ll Ed K
EE13 1] 50000 i} E4 k.
EE14 1] EO00D =i} B4 k.
EE15 Mo FO00a R} B4 k.

Select Al Select Written Eraze

Select All

Clicking onSelect Allwill select all the blocks of the device FLASH memory.

Select Written

Clicking onSelect Written will select only those blocks that are not empty.

Erase

Clicking onErasewill erase the data in the selected blocks and removes the ‘Erase Block’ dialog box.

Cancel
Clicking onCancelremoves the ‘Erase Blocks’ dialog box without performing an erase operation.

Note Whilst blocks that contain no data need not be erased, FDT will erase all the specified blocks.
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6.17 FLASH Controller

In order to launch the ‘FLASH Controller’ dialog box an S-Record or other binary image file that is not part of a
currently open Project must be open in the editor. The ‘FLASH Controller’ dialog box is then launched by
[Image->Download file namg.

The ‘FLASH Controller’ dialog box provides a quick and easy way to download files to the Target device.

toller: '0-7F mat’

Device Selection

This allows the user to select the Target device from a drop-down list. It also shows the FLASH and RAM size.

Commands

Connect/Disconnect

Connects or disconnects the Interface to the selected device.

Blank check

Carries out a blank check on the device FLASH memory.

Erase FLASH blocks

This invokes the ‘Erase Blocks’ dialog box.
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User settings

This allows the user to use the default baud rate or select a rate and also select the communication port to be
used.

Connection

This allows the user to seld8OOT Mode or USER Program Modeand ‘Direct Connection’ Interface.

BOOT Mode

This connection type specifies that the BOOT sequence is to be initiated if a kernel cannot be found running on
the target device. This will cause the whole of the FLASH to be erased and a kernel loaded.

If a kernel is already resident, the FLASH is not erased; rather, information regarding the block usage is
obtained to prevent accidental over programming.

USER Program Mode

This connection type specifies that the on-board programming USER Program mode sequence is to be initiated
where by a previously loaded user program is used to reprogram the FLASH memory.

Select Interface

Only the ‘Direct Connection’ interface is available.

Kernel already resident

This control indicates if a kernel is already resident on the target device.

Kernel

This selects the frequency, multiplier, and protocol.

Download file ‘file name’ to device
Clicking on this downloads the associated image to the device FLASH memory.

The FLASH Controller implements interactive device protection, see on-line Help. If an attempt is made to
write to an area of the FLASH memory that has already been written to, the user will be queried before the
programming operation starts.

When a FLASH Controller is launched an Output window will be created where messages will be directed. If
the user wishes to save these messages he must do so before he closes the associated image file.
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6.18 Customise - Toolbars

Invoked by[Iools->Customise...]in the ‘Customise FLASH Development Toolkit' dialog box.

Customize FLASH Development Toolkit x|

Toolbars |C0mmands| Outpuit Windowl Generall

Toolb

v Show Tooltips Hew...
\I;'\:ooitgtp ace [V Cool Look —
glt;ndard [ Large Buttons =

onllar manmes

Menu bar

ak. I Cancel

Show Tooltips

A check mark in th&how Tooltipsbox indicates that the action of the button will be displayed when the mouse
arrow is pointing to the button. If the box is unchecked, no action is displayed.

Cool Look

A check mark in th€ool Look box removes the border around all menu and toolbar items. If the box is
unchecked, the borders are visible.

Large Buttons

Checking theLarge Buttons box increases the size of the buttons.

New...

TheNew... button launches the ‘Toolbar Name’ dialog box which allows the user to name and generate a new
toolbar. After entering the new name and clickingdi, the new name will be added to the Toolbars list and

an empty toolbar is displayed on the interface.

Selecting the Commands tab allows the user to select and add buttons to the new toolbar. The user can place the
new toolbar anywhere on the GUI by dragging it with the mouse.

Reset

TheResetbutton resets the toolbar to the default.
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Toolbar name

Reflects the toolbar selected in the list.

OK

Clicking onOK, in the ‘Toolbar Name’ dialog box adds the new name to the Toolbars list on the Toolbars
window and invokes a blank toolbar on the GUI.

Clicking onOK in the ‘Customise FLASH Development Toolkit' dialog box saves any changes made and
closes the dialog box.

Delete

If a new toolbar has been added to the Toolbars list and it is select®dsbibutton is renamed telete
Clicking on this button will remove the new toolbar from the list and from the GUI.

Cancel

Clicking onCancelremoves the ‘Customise FLASH Development Toolkit' dialog box without saving any
changes made.

6.19 Customise - Commands

Invoked by[IooIs—>Customise...]and then select the Commands tab in the ‘Customise FLASH Development
Toolkit’ dialog box.

Customize FLASH Development Toolkit x|

Toolbars  Commands |E|ut|:|ut Windowl Generall

Categories: — Buttonz

3 EEE fRBo o o
oject

‘Waorkspace = 7 E
o = abe I | 0B Ga o |4

Select a category, then click a button to see its description. Drag the button
to any toolbar

Description

ak. I Cancel

Categories

Clicking on a Category from the list displays the buttons available for that category.
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Buttons

TheButtons area displays a picture of each button available for the selected category.

Description

To obtain a description of the action of a button, click on that button.

OK

Clicking onOK removes the ‘Customise FLASH Development Toolkit' dialog box and saves any changes
made.

Cancel
Clicking onCancelremoves the ‘Customise FLASH Development Toolkit' dialog box without saving any
changes made.

6.20 Customise — Output Window

Invoked by[IooIs—>Customise...]and then select the Output Window tab in the ‘Customise FLASH
Development Toolkit’ dialog box.

Customize FLASH Development Toolkit x|

Toolbalsl Commands  Clutput Wfindow | Generall

The Output window can display text in any font. You can also chooze to
dizplay differert types of meszages in different colours.

—Meszages

essage

=
WARNING : Message EhangeCnIour...l

ERROE : Message

Success Message
g Change Font... |
=

You may alzo specify the Font far the Output window T abs,
— Tabs

AaBbyYyiz

Change Font... |
ak. I Cancel |

Messages

Change Colour

Clicking onChange Colour...invokes the ‘Colour’ dialog box. This button allows the colour of the message to
be changed.
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Change Font

Clicking onChange Font...invokes the ‘Font’ dialog box. This button allows the font of the message to be
changed.

Tabs

Change Font

Clicking onChange Font...invokes the ‘Font’ dialog box. This button allows the font of the message-window
tab to be changed.

OK

Clicking onOK saves any changes made and closes the ‘Customise FLASH Development Toolkit’ dialog box.

Cancel

Clicking onCancelcloses the ‘Customise FLASH Development Toolkit’ dialog box without saving any
changes made.
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6.21 Customise - General

Invoked by[IooIs->Customise...]and then select the General tab in the ‘Customise FLASH Development
Toolkit’ dialog box.

Customise FLASH Development Toolkit x|

Toolbalsl Commandsl Output Wwindaw  General |

Idze this page to specify general FOT options

— Programming

Wwiould you like to perfarm read-back
verification after programming 7

Wiould pou like to reset the dewvice
when discorngecting ? IQUBI}' 'I

[Juery ~

—&utomation

™ Beload last Workspace at startup

I™ | Download active project Device. [mage abetartip

ak. I Cancel

Programming

Read-back verification

The options are that it will prompt to determine if a read-back verification takes place (Query) or that it always
will verify (Yes) or never (NO).

Reset on disconnect

(Feature not currently available)
Automation

Reload last Workspace at startup

Checking this option allows the last used Workspace to be loaded when running FDT.

Download active project Device Image at startup

Checking this option allows the FDT to automatically write the device image of the active project to the FLASH
memory.

OK

Clicking onOK closes the ‘Customise FLASH Development Toolkit’ dialog box and saves any changes made.
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Cancel

Clicking onCancelcloses the ‘Customise FLASH Development Toolkit' dialog box without saving any
changes made.

6.22 Simple Interface
Invoked by[IooIs->SimpIe Interface...].Clicking onEXIT displays the previous screen.

! FLASH Development Toolkit 2.1 - Rocket Launcher

EMFDTYProjectFile’\Rocket Launcherézimut I_

R

Launch Sequencer

Flash Program

Clicking onFlash Programallows the FDT to download the specified file to the FLASH memory.
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